
Contents for SkyView Help
To learn how to use Help, press F1.

General Information
Introduction to SkyView
Requirements
Contents of the SkyView Window
Contents of the Legend Window
Projection Used by SkyView
Copyright

How to...
Add the Ecliptic, Celestial Equator, Galactic Equator, and Equatorial Coordinates
Change the Date and Time
Change the Number of Stars Displayed
Change the Observer's Coordinates
Change the Sky Display Colors
Change the Sky Display Orientation

Commands
File Menu
Options Menu
Display Menu
Colors Menu
Help Menu

Notes
Development
Acknowledgments
Contacting the Author
Version History



Introduction to SkyView

SkyView performs many of the functions of a planetarium. It allows you to see the appearance of the sky 
from any specified location on the earth. You can change the date and time for which the sky is displayed 
to see the sky as it looked in the past or as it will look in the future.

SkyView displays the positions of the sun, moon, and all naked-eye planets, as well as all the stars down 
to a limiting magnitude you select. You can orient the sky display so that the North, South, East, or West 
horizon is positioned at the bottom of the screen. The ecliptic, celestial equator, galactic equator, and 
equatorial coordinate lines can be added to the display in any combination. You even have control of the 
colors used for most of the sky objects and for the background.

SkyView is a valuable tool for interactively exploring the fundamentals of astronomy or for planning your 
observation time.

How much does SkyView cost? Absolutely nothing! SkyView is free software. I wrote the Windows 
version of SkyView entirely for fun, for my own use, and to learn more about and practice programming 
Windows. See Development for more information about other versions of SkyView.

As with any software, bugs are expected, as are opportunities for improvement. Please see Contacting 
the Author for information on how to report bugs and suggest improvements.



Requirements

SkyView requires Windows 3.1 to run. It may also work just fine with Windows 3.0, but I don't know 
anybody still running 3.0 so I can't claim to know it will work.

A math coprocessor is not required, but without one generating the sky display will take significantly 
longer than if a coprocessor is present.

SkyView requires at least a 256-color video mode to work properly. It is simply impossible to display the 
stars in different colors and intensities of white as well as the planets in unique colors if only 16 colors are 
available. Dithered colors are unacceptable when the area being colored is small, as is the case with the 
symbols used to represent the planets.



Contents of the SkyView Window

The SkyView window contains a display of the entire sky visible at a given date and time. Imagine lying 
on your back far away from buildings, mountains, or trees and looking straight up at the sky. The sky 
display may contain the sun, moon, and all or some of the naked-eye planets. Of course you can't really 
see all of these objects when the sun is in the sky. SkyView shows you what you would see if you could. 
At certain times you may see no objects other than stars. The positions of the planets Uranus, Neptune, 
and Pluto are never shown as these planets cannot be seen without the aid of binoculars or a telescope.

The number of stars in the display depends on the selected limiting magnitude. The greater the limiting 
magnitude, the more stars will be displayed and the longer it will take to generate the sky display. See 
Changing the Number of Stars Displayed for more information.

The stars are represented in the display by symbols of different sizes and colors. Naturally, larger 
symbols represent brighter stars and smaller symbols represent dimmer stars. Although the star database
used by SkyView contains information about the colors of all the stars, only stars in the top three 
brightness levels are displayed in color. Only the brightest stars in the real sky appear to be colored. The 
colors of the stars are subtle. In addition to white, bright stars may appear to have a touch of blue, yellow, 
or red in them. Dimmer stars are displayed using only white and a few levels of gray.

You can choose which horizon is positioned at the bottom of the sky display. See Changing the Sky 
Display Orientation for more information.

You can choose to display lines on the celestial sphere representing the ecliptic, celestial equator, galactic
equator, and the equatorial coordinate system. See Adding the Ecliptic, Celestial Equator, Galactic 
Equator, and Equatorial Coordinates for more information.

You can position and size the SkyView window to your liking. This information is saved when you exit 
SkyView. The window will be restored to the previous position and size when you start SkyView again.



Contents of the Legend Window

The upper part of the Legend window contains a legend of symbols used in the sky display.

All symbols are shown in the legend regardless of whether a given object is visible in the sky at the 
specified date and time. The symbols for the ecliptic, celestial equator, galactic equator, and equatorial 
coordinates are grayed when these lines are not being displayed. They will appear in color when the lines
are selected for display.

The lower part of the Legend window contains the local time, universal time, local sidereal time, and 
Julian date.

The local time is obtained from your computer's system clock when the application is first started, or from
the Date and Time dialog box from then on. The local time is assumed to be standard time, unless the 
Daylight-Saving-Time box is checked. The sky display will be incorrect if your computer's system clock is 
not properly set.

Universal time (UT) is simply the mean solar time measured on the meridian at Greenwich, England (0 
degrees longitude). The universal time is determined from the your local time. In order for this to be done 
correctly, you must set your location using the Coordinates dialog box. The time zone value in this dialog 
box is used to convert between local time and universal time.

Sidereal time (ST) is time measured by reference to the rotation of the earth with respect to the stars. 
Our common solar time is measured by reference to the rotation of the earth with respect to the sun. With 
respect to the stars, the earth takes 23 hours, 56 minutes, and 4.091 seconds to spin once on its axis. 
This quantity is known as a sidereal day. During this period the earth moves along in its orbit around the 
sun. Because of this motion, it takes roughly another four minutes before the earth has spun once on its 
axis with respect to the sun. This 24-hour period is known as a solar day.

The definition of the local sidereal time (LST) at a given instant is such that it equals the right ascension 
currently found on the prime meridian, the line running from north to south and passing directly over your
head. For example, the star Betelgeuse in the constellation Orion has a right ascension of about 05:54. If 
the sidereal time is 06:00, you know that Betelgeuse is very near the prime meridian.

The Julian date (JD) is the number of days that have passed since noon universal time on 1 January 
4713 BC. This figure includes the decimal fraction of the day that has elapsed since the preceding noon. 
The Julian date system was invented in 1582 by the French scholar Joseph Scalinger.

The Julian date is very useful because the consecutive numbering of days makes the system 
independent of the varying lengths of months and years. To find the number of days between two events, 
simply determine the Julian dates of those events and subtract one date from the other.



Projection Used by SkyView

I have seen a number of astronomy programs for Windows, DOS, and the Macintosh. Some of these 
programs have an option to display the entire sky at once. These sky displays all use a very misleading 
projection of the sky on the computer screen.

It is common to think of the sky being a large dome over our head and the stars being fixed on the inner 
surface of this dome. We think of ourselves viewing the inside of this dome from right in the middle of the 
base of the dome. Other programs incorrectly display the sky as if we were looking at the inside of the 
dome from a great distance away. Stars seem to be concentrated around the edge of the sky display 
rather than be distributed evenly across the sky. Constellations are foreshortened, as if you were viewing 
them at a shallow angle. Ask yourself this: does the real sky ever look like this? The answer is clearly no!

Look at a continent on a globe of the earth. If the continent is right in front of you it looks the way you 
expect it to look. Spin the globe so that the continent is moving away from you. The closer it gets to the 
the edge of the globe the more distorted it looks. Spin the globe a little more and the continent disappears
to the back side. This is all very normal if you are viewing the globe from a few feet away. But what if you 
were inside the globe--at the very center--and could look out and see the continents. They would always 
look the same; there would be no distortion.

The same idea applies to the stars in the sky. You are viewing the dome of the sky from the inside, not 
from a great distance away. The one thing different in the case of the sky is that the earth is not 
transparent--we can only see half of the sky at one time. Objects near the horizon appear larger than 
those that are higher up in the sky. This is just an optical illusion, but it is important to keep in mind when 
thinking about how the sky really looks. A constellation near the horizon will look larger than it does when 
it is high in the sky, not smaller as many other programs will display it.

You cannot display a three-dimensional surface like the dome of the sky on a two-dimension surface like 
a computer screen without distortion. But there are different ways to project the 3D surface onto the 2D 
surface, and some ways are clearly better than others. I think the projection used by this program displays
the sky in a much more realistic fashion that do other programs. Constellations are distorted, but they are 
distorted in a way that simulates the actual appearance of the sky.



Copyright

Copyright © 1993 Stephen Michael Schimpf. All Rights Reserved.

Permission is granted to any individual or institution to use, copy, or distribute this software, provided all of
the original files are included unmodified and that it is not sold for profit.



Adding the Ecliptic, Celestial Equator, Galactic Equator, and Equatorial 
Coordinates

The Lines command on the Display menu displays the Lines dialog box. This dialog box contains four 
check boxes that allow you to add the ecliptic, celestial equator, galactic equator, and equatorial 
coordinates to the sky display in any combination.

The ecliptic is the great circle which the plane of the earth's orbit around the sun forms where it 
intersects the celestial sphere. In simpler words, the ecliptic is the line in the sky along which the sun 
appears to move during the course of a year. The sun moves roughly one degree along this line every 
day. Because the orbits of the naked-eye planets have inclinations of seven degrees or less, you will 
always find the planets on or very close to this line.

The celestial equator is simply the great circle formed by extending the earth's equatorial plane out to 
the celestial sphere. The axis of the earth's daily rotation is tilted with respect to its orbital plane, and 
therefore the ecliptic and celestial equator are tilted with respect to each other. This angle, known as the 
obliquity of the ecliptic, is currently roughly 23.5 degrees.

The galactic equator is the equator of our galaxy, the Milky Way. You will notice that at large limiting 
magnitudes the number of stars in the sky display is larger around the galactic equator than in other areas
of the sky. You are seeing the concentration of stars along the plane of our galaxy.

Lines of the equatorial coordinate system are displayed ten degrees apart. The lines that run from pole 
to pole are lines of right ascension, and those that run parallel to the celestial equator are lines of 
declination. The right ascension and declination system is similar to the longitude and latitude system 
used on the surface of the earth.

When you exit SkyView the changes you make in the Lines dialog box are saved. If you always want 
certain lines included in the sky display, simply select them in the dialog box. When you leave SkyView 
your preferences become the default.



Changing the Date and Time

The Date and Time command on the Options menu displays the Date and Time dialog box. This allows 
you to change the year, month, day, hour, minute, and second for which the sky is to be displayed. You 
should enter local time, not universal time. In order for the local values you enter to be converted 
correctly into universal time, the time zone for your location must be correct. Use the Coordinates 
command on the Options menu to set your location and time zone.

The date and time you enter is restricted to the following ranges:

Year 1900-2100 Hour 0-23
Month 1-12 Minute 0-59
Day 1-31 Second 0-59

You will be warned by a message box if you enter a value that is out of range.

If daylight-saving time is in effect, check the Daylight-Saving-Time box. This causes one hour to be 
subtracted from the time zone value to correctly convert from local time to universal time. The state of this
check box is saved when you exit SkyView and restored when you start the application again.

Use the Now button to quickly set the date and time values to your computers current system date and 
time.



Changing the Number of Stars Displayed

The Magnitudes command on the Display menu displays the Magnitudes dialog box. This allows you to 
select the limiting magnitude of stars displayed. The default is to display stars down to magnitude 4.0. 
Using the scroll bar you can select any limiting magnitude between 3.0 and 6.4.

Magnitudes are used in astronomy for historical reasons. In ancient times the stars were ranked in six 
classes of magnitude. The brightest stars were first magnitude and the faintest just visible to the naked 
eye were sixth magnitude. This system became inadequate with the invention of the telescope, when 
many fainter stars were discovered.

In 1856 the English astronomer N.R. Pogson proposed that a difference of five magnitudes correspond 
exactly to a brightness ratio of 100 to 1. The brightness ratio of two stars that differ by one magnitude is 
the fifth-root of 100, or 2.512, a quantity known as the Pogson ratio. A star that has a magnitude two less
than another star is 2.512 squared, or about 6.3 times brighter than the other star.

Therefore, the larger the limiting magnitude you select the more faint stars will be displayed. Remember 
that the more stars that are displayed, the longer it will take to generate the sky display. For those of you 
without a math coprocessor, this can make a big difference.

Selecting 6.4 as a limiting magnitude will display all 7788 stars in the SkyView database. You only see 
half this many stars at one time because you only see half of the sky at one time. Also, you will only be 
able to see down to magnitude 6 under very good seeing conditions far away from city lights.

When you exit SkyView the currently selected limiting magnitude becomes the default.



Changing the Observer's Coordinates

The Coordinates command on the Options menu displays the Coordinates dialog box. This allows you to
select the vantage point on the earth from which the sky is being viewed. When SkyView is first run, the 
default values used are for Los Angeles: latitude 34.05 North, longitude 118.25 West, and time zone -8.0.

The Location box shows you the name of the currently selected location. Using this box you can select 
one of a number of cities in the United States (and other countries if those locations have been defined). 
Simply select a city from the list, and the correct latitude, longitude, and time zone values will be entered 
for you. If the city where you live is not one of the cities in the list, select the closest city that you can find. 
This should be satisfactory.

You can select locations on a temporary basis by exiting the dialog box using the OK button. You can 
view the sky at a number of locations in this way without affecting the default location that is used when 
you start SkyView. To change the default location, select it from the list and then exit the dialog box by 
choosing the Save button.

If you want to add a new location to the database, follow these steps:

1. Type the name of the new location in the Location box.

2. Type the latitude and longitude of the location in the Latitude and Longitude controls. Following 
astronomical convention, West longitudes are negative. If the latitude or longitude is a negative value, 
be careful not to type a minus sign. Instead, select the South or East radio button.

3. Type the time-zone value for standard time at the location in the Time Zone control. The time-zone 
value is the difference between local standard time and universal time. For example, Pacific Standard 
Time (PST) is eight hours behind universal time. The correct time zone value in this case is -8.0.

Here are time-zone values for time zones in the continental United States:

Eastern -5
Midwest -6
Mountain -7
Pacific -8

4. Choose the Save button.

The information for the location will be added to the location database, and this location will become the 
new default location.



Changing the Sky Display Colors

The commands on the Colors menu display a dialog box that allows you to change the color of the 
window background or of most of the items in the sky display.

SkyView paints the sky display using pure rather than dithered colors. For this reason I avoid using 
Microsoft's common Color dialog box. My color-selection dialog box contains 27 pure colors listed by 
name.

The Background command displays the Background color dialog box. This allows you to change the 
color of the background of the SkyView and Legend windows. The default Background color is Blue.

The Mercury command displays the Mercury color dialog box. This allows you to change the color of the 
symbol used to represent the planet Mercury. The default color for Mercury is Cornflower Blue.

The Venus command displays the Venus color dialog box. This allows you to change the color of the 
symbol used to represent the planet Venus. The default color for Venus is Violet.

The Mars command displays the Mars color dialog box. This allows you to change the color of the symbol
used to represent the planet Mars. The default color for Mars is Red.

The Jupiter command displays the Jupiter color dialog box. This allows you to change the color of the 
symbol used to represent the planet Jupiter. The default color for Jupiter is Yellow.

The Saturn command displays the Saturn color dialog box. This allows you to change the color of the 
symbol used to represent the planet Saturn. The default color for Saturn is Orange.

The Ecliptic command displays the Ecliptic color dialog box. This allows you to change the color of the 
symbol used to represent the ecliptic. The default color for the ecliptic is Green.

The Celestial Equator command displays the Celestial Equator color dialog box. This allows you to 
change the color of the symbol used to represent the celestial equator. The default color for the celestial 
equator is Firebrick.

The Galactic Equator command displays the Galactic Equator color dialog box. This allows you to 
change the color of the symbol used to represent the galactic equator. The default color for the galactic 
equator is Cornflower Blue.

The Equatorial Coordinates command displays the Equatorial Coordinates color dialog box. This allows 
you to change the color of the symbol used to represent equatorial coordinates (right ascension and 
declination). The default color for equatorial coordinate lines is Slate Blue.

The Default Colors command restores all the user-selectable SkyView colors to their original "factory" 
values.

When you exit SkyView the current color preferences are saved and are the default colors when you start 
SkyView again.



Changing the Sky Display Orientation

The Horizons command on the Display menu displays the Horizons dialog box. This allows you to select 
which horizon (North, South, East, or West) you want positioned at the bottom of the sky display. The 
default is to display the South horizon at the bottom of the display.

When you exit SkyView the currently selected sky-display orientation is saved and is the default when you
start SkyView again.



File Menu

Exit closes the SkyView application. The positions and sizes of the SkyView and Legend windows as well
as many of the values you have set in dialog boxes are saved when you exit SkyView and will be restored
when you start the application again.



Options Menu

Date and Time allows you to change the year, month, day, hour, minute, and second for which the sky is 
to be displayed. See Changing the Date and Time for more information.

Coordinates allows you to select the location on the earth from which you are viewing the sky. See 
Changing the Observer's Coordinates for more information.



Display Menu

Limiting Magnitudes allows you to select the limiting magnitude of stars displayed. See Changing the 
Number of Stars Displayed for more information.

Horizons allows you to select which horizon (North, South, East, or West) you want positioned at the 
bottom of the sky display. See Changing the Sky Display Orientation for more information.

Lines allows you to display the ecliptic, celestial equator, galactic equator, and equatorial coordinate 
system lines on the sky display in any combination. See Adding the Ecliptic, Celestial Equator, Galactic 
Equator, and Equatorial Coordinates for more information.



Colors Menu

Background allows you to change the color of the background of the SkyView and Legend windows.

Mercury allows you to change the color of the symbol used to represent the planet Mercury.

Venus allows you to change the color of the symbol used to represent the planet Venus.

Mars allows you to change the color of the symbol used to represent the planet Mars.

Jupiter allows you to change the color of the symbol used to represent the planet Jupiter.

Saturn allows you to change the color of the symbol used to represent the planet Saturn.

Ecliptic allows you to change the color of the line used to represent the ecliptic.

Celestial Equator allows you to change the color of the line used to represent the celestial equator.

Galactic Equator allows you to change the color of the line used to represent the galactic equator.

Equatorial Coordinates allows you to change the color of the lines used to represent equatorial 
coordinates (right ascension and declination).

Default Colors restores all the user-selectable SkyView colors to their original "factory" values.

See Changing the Sky Display Colors for more information.



Help Menu

Contents opens the Windows Help application to allow you to access help for SkyView.

How to Use Help opens the Windows Help application to allow you to learn more about using Help.

About displays an About dialog box containing limited information about the SkyView application.



Development

Tools Used

SkyView was written entirely in C++ and the Microsoft Foundation Classes. The following tools were used
to develop SkyView:

Microsoft C/C++ 7.00
Microsoft Programmer's WorkBench 2.00
Microsoft Windows Software Development Kit 3.10
Microsoft Word for Windows 2.0b.

Yes, I do like Microsoft products! The Programmer's WorkBench usually gets a bad rap, but I like the way 
it works. I have tried stand-alone editors but always found them a hassle to customize and use. Why 
maintain a make file by hand when you can have your programming environment do it for you? In my 
opinion no stand-alone editor can compare to an integrated development environment. Once you get 
used to the on-line help and source and class browsers there's no going back. I just wish Microsoft would 
turn PWB into a Windows application!

Sources

This application could not have been written without the help of the following excellent book. Anyone 
thinking about getting into programming Windows should take a look at this book.

Charles Petzold. 1992, Programming Windows 3.1, Third Edition. (Redmond, Washington: Microsoft 
Press). ISBN 1-55615-395-3.

For more information about the astronomical calculations performed in SkyView, see

Duffett-Smith, P. 1990, Astronomy with Your Personal Computer, Second Edition, (Cambridge: 
Cambridge University Press). ISBN 0-521-38995-X.

Green, R.M. 1985, Spherical Astronomy, (Cambridge: Cambridge University Press).

Meeus, J. 1991, Astronomical Algorithms. (Richmond: Willmann-Bell). ISBN 0-943396-35-2.

History

The original SkyView was developed about five years ago when I was still an undergraduate working for 
Drs. Plavec and Keyes at the UCLA Department of Astronomy. This original program was written entirely 
in FORTRAN and ran on a VAX 750. The sky display was produced on a Ramtek monitor and projected in
a classroom. Professors displayed the sky for hundreds of students taking introductory astronomy classes
each quarter at UCLA.

After starting the FORTRAN version I developed a DOS version of SkyView for my own use at home 
using Borland Turbo C 1.5 and later 2.0. I targeted the program not at education but for use by amateur 
astronomers who wanted to plan their telescope time in advance. I switched to Microsoft QuickC 2.01 and
developed an improved version that I distributed to friends.

When I got into Windows programming I developed a version for Windows 3.0 using Microsoft C and the 
Software Development Kit 3.0. This version was also only distributed to friends. Finally, after converting
the entire program source code and supporting library routines into C++ using the Microsoft Foundation 
Classes, I decided to write the necessary documentation and package SkyView so it could be distributed 
freely. I hope it is useful to someone.

After getting my BS in Astrophysics and my MS in Astronomy from UCLA, I was hired to work as the 



department's programmer on the Science Challenge project. The purpose of this NSF-funded project is to
develop interactive educational modules for six UCLA physical science departments. I have developed a 
version of SkyView in C for the X Window System using OSF/Motif. This program is currently used on 
DECstation 5000s in our department and on SGI Indigos in UCLA's Physical Sciences Learning Center. 
Although I very much prefer the development tools available on the PC to those available to me under 
UNIX, I was impressed to see how easy it was to port SkyView from a DECstation to an Indigo. Also, 
these workstations are not limited by poor hardware as is the PC, so the X version of SkyView was written
to display the sky using very smooth animation.
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Contacting the Author

If you have any questions, comments, or suggestions for improvements, you can contact me by USPS or 
Internet mail using the following addresses:

Stephen Michael Schimpf
2444 West 230th Street
Torrance, CA 90501-5242

Stephen Michael Schimpf, Programmer/Analyst II
University of California, Los Angeles
Department of Astronomy
8979 Math Sciences Building
Los Angeles, CA 90024-1562

stephen@eggneb.astro.ucla.edu



Version History

Version 1.00 (Monday, 8 February 1993)
-    First release for Microsoft Windows 3.10 or higher. Built using Microsoft C/C++ 7.00.




